PDF Accessibility for Everyone
Andrew Kirkpatrick | Group Product Manager, Accessibility
Accessibility Is All About End-Users

- End users include people with disabilities.
  
  - **Sensory** – includes blindness, low-vision, color-deficient vision, deafness, hard-of-hearing, photo-sensitive seizures.
  
  - **Physical** – includes paralysis, RSI, muscular dystrophy, cerebral palsy.
  
  - **Cognitive** – includes users who perceive and process information differently or with greater difficulty. Very diverse range of user needs within this group.

  - Users may have multiple disabilities (e.g. a deaf-blind user)
Why Do We Care About Accessibility?

- Under the Disability Discrimination Act of 1992 agencies must ensure that people with disabilities have the same fundamental rights to access information and services as others in the community.

- The Australian Government ratified the UN Convention on the Rights of Persons with Disabilities in 2008, which specifically recognises that access to information, communications, and services is a human right.

- The Online and Communications Council (OCC) adopted WCAG 2.0 in 2009.
  - WCAG 2.0 is a W3C standard for accessibility (pronounced Wuh-CAG)
  - All Australian, state and territory government websites need to meet WCAG 2.0 Level A by December 2012.
  - All FMA Act Agencies need to meet to WCAG 2.0 Level AA by December 2014.
The First Step

New documents must be accessible

(existing documents are no less important, but are a separate issue)
What Makes a Document Accessible?

Key points*

- Correct semantic structure
- Equivalents for images
- Understandable information
- Proper identification of language
- Resizable text
- Proper colour and contrast

*This list is a simplification of WCAG 2.0 but covers common document issues.
Correct Semantic Structure

What is the difference between this:

Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years, bringing vital and engaging experiences to people across media and to every screen in their lives, at work and at play.

The impact of Adobe software is evident almost everywhere you look. Whether people are collaborating at work, transacting online, or socializing with friends, businesses use Adobe software and technologies to turn digital interactions into richer, high-value experiences that reach across computing platforms and devices to engage people anywhere, anytime.

With a reputation for excellence and a portfolio of many of the most respected and recognizable software brands, Adobe is one of the world’s largest and most diversified software companies.

A rich history of innovation

Our commitment to innovation is as strong today as it was in 1982, when Chuck Geschke and John Warnock founded Adobe. The two men initially set out to solve a problem long familiar to creative
Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years, bringing vital and engaging experiences to people across media and to every screen in their lives, at work and at play.

The impact of Adobe software is evident almost everywhere you look. Whether people are collaborating at work, transacting online, or socializing with friends, businesses use Adobe software and technologies to turn digital interactions into richer, high-value experiences that reach across computing platforms and devices to engage people anywhere, anytime.

With a reputation for excellence and a portfolio of many of the most respected and recognizable software brands, Adobe is one of the world’s largest and most diversified software companies.

A rich history of innovation

Our commitment to innovation is as strong today as it was in 1982, when Chuck Geschke and John Warnock founded Adobe. The two men initially set out to solve a problem long familiar to creative
Correct Semantic Structure

What is the difference between this:

Our report will detail:

* The total number of companies in the database, including
  * The total number of contacts per company
  * The number of sites per company
  * The industry/segment of each company
* The total number of contacts in the database
* Data on the types of contacts in the database, including
  * Personal interest demographics
  * Business interest demographics
Correct Semantic Structure

And this:

Our report will detail:

- the total number of companies in the database, including
  - the total number of contacts per company
  - the number of sites per company
  - the industry/segment of each company
- the total number of contacts in the database
- data on the types of contacts in the database, including
  - personal interest demographics
  - business interest demographics
Correct Semantic Structure

What is the difference between this:

Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years, bringing vital and engaging experiences to people across media and to every screen in their lives, at work and at play.

The impact of Adobe software is evident almost everywhere you look. Whether people are collaborating at work, transacting online, or socializing with friends, businesses use Adobe software and technologies to turn digital interactions into richer, high-value experiences.

A rich history of innovation

Our commitment to innovation is as strong today as it was in 1982, when Chuck Geschke and John Warnock founded Adobe. The two men initially set out to solve a problem long familiar to creative professionals at the time: getting text and images on a computer screen to translate beautifully and accurately into print. A year later, they helped launch the desktop publishing revolution with Adobe PostScript, a technology that took the publishing world by storm with its radical new approach to printing text and images.
Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years, bringing vital and engaging experiences to people across media and to every screen in their lives, at work and at play.

The impact of Adobe® software is evident almost everywhere you look. Whether people are collaborating at work, transacting online, or socializing with friends, businesses use Adobe software and technologies to turn digital interactions into richer, high-value experiences.

A rich history of innovation

Our commitment to innovation is as strong today as it was in 1982, when Chuck Geschke and John Warnock founded Adobe. The two men initially set out to solve a problem long familiar to creative professionals at the time: getting text and images on a computer screen to translate beautifully and accurately into print. A year later, they helped launch the desktop publishing revolution with Adobe PostScript®, a technology that took the publishing world by storm with its radical new approach to printing text and images.
What is the difference between this:

<table>
<thead>
<tr>
<th>Conference Room</th>
<th>Floor</th>
<th>Extension</th>
<th>Video Conferencing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>3&lt;sup&gt;rd&lt;/sup&gt;</td>
<td>3-1234</td>
<td>No</td>
</tr>
<tr>
<td>Beta</td>
<td>3&lt;sup&gt;rd&lt;/sup&gt;</td>
<td>3-4321</td>
<td>Yes</td>
</tr>
<tr>
<td>Gamma</td>
<td>2&lt;sup&gt;nd&lt;/sup&gt;</td>
<td>2-1235</td>
<td>No</td>
</tr>
</tbody>
</table>
Correct Semantic Structure

And this:

<table>
<thead>
<tr>
<th>Conference Room</th>
<th>Floor</th>
<th>Extension</th>
<th>Video Conferencing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>3rd</td>
<td>3-1234</td>
<td>No</td>
</tr>
<tr>
<td>Beta</td>
<td>3rd</td>
<td>3-1235</td>
<td>Yes</td>
</tr>
<tr>
<td>Gamma</td>
<td>2nd</td>
<td>5-4321</td>
<td>No</td>
</tr>
</tbody>
</table>
Correct Semantic Structure

- **Headings** provide structure needed to convey how documents are organized.

Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years, bringing vital and engaging experiences to people across media and to every screen in their lives, at work and at play.

The impact of Adobe software is evident almost everywhere you look. Whether people are collaborating at work, transacting online, or socializing with friends, businesses use Adobe software and technologies to turn digital interactions into richer, high-value experiences that reach across computing platforms and devices to engage people anywhere, anytime.

With a reputation for excellence and a portfolio of many of the most respected and recognizable software brands, Adobe is one of the world’s largest and most diversified software companies.

A rich history of innovation

Our commitment to innovation is as strong today as it was in 1982, when Chuck Geschke and John Warnock founded Adobe. The two men initially set out to solve a problem long familiar to creative
Correct Semantic Structure

- **Headings** provide an outline-like structure which simplifies comprehension of documents, particularly for blind and low-vision users.

- Some tools provide an interface to navigate among headings.
Correct Semantic Structure

- **Lists** provide information about a collection of related items
- Lists can indicate number of items and can be nested to indicate the association of related items

Our report will detail:

- the total number of companies in the database, including
  - the total number of contacts per company
  - the number of sites per company
  - the industry/segment of each company
- the total number of contacts in the database
- data on the types of contacts in the database, including
  - personal interest demographics
  - business interest demographics
Correct Semantic Structure

- **Columns** convey the linear order of information correctly.

Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years, bringing vital and engaging experiences to people across media and to every screen in their lives, at work and at play.

The impact of Adobe software is evident almost everywhere you look. Whether people are collaborating at work, transacting online, or socializing with friends, businesses use Adobe software and technologies to turn digital interactions into richer, high-value experiences.

A rich history of innovation

Our commitment to innovation is as strong today as it was in 1982, when Chuck Geschke and John Warnock founded Adobe. The two men initially set out to solve a problem long familiar to creative professionals at the time: getting text and images on a computer screen to translate beautifully and accurately into print. A year later, they helped launch the desktop publishing revolution with Adobe PostScript, a technology that took the publishing world by storm with its radical new approach to printing text and images.
Correct Semantic Structure

- **Tables** convey complex relationships in data in ways that can’t otherwise be captured.
- Data within a table can be located by row, column, and heading, and easily understood.
- Data separated by tab stops and carriage returns is just a bunch of numbers and words.

<table>
<thead>
<tr>
<th>Conference Room</th>
<th>Floor</th>
<th>Extension</th>
<th>Video Conferencing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>3rd</td>
<td>3-1234</td>
<td>No</td>
</tr>
<tr>
<td>Beta</td>
<td>3rd</td>
<td>3-1235</td>
<td>Yes</td>
</tr>
<tr>
<td>Gamma</td>
<td>2nd</td>
<td>5-4321</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conference Room</th>
<th>Floor</th>
<th>Extension</th>
<th>Video Conferencing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>3rd</td>
<td>3-1234</td>
<td>No</td>
</tr>
<tr>
<td>Beta</td>
<td>3rd</td>
<td>3-1235</td>
<td>Yes</td>
</tr>
<tr>
<td>Gamma</td>
<td>2nd</td>
<td>5-4321</td>
<td>No</td>
</tr>
</tbody>
</table>
Equivalents for Images

- Images that convey information need underlying text to enable some users to understand what the image is conveying.

- Equivalent text for this image could be “Global Corp logo”, or just “Global Corp”.

- Equivalent text **would not** be “This is a picture of the GlobalCorp logo, with a large green letter G and a large black-colored and backward letter C, both above the word ‘GlobalCorp’ (also in green and black)”
Understandable Information

- Users benefit from documents having a **clearly defined document title** and **clear link text**.

**Link Text**

- Link text should always include information about the link destination sufficient for users to know what they are linking to.
- Good link text: The [fiscal year 2011 budget](#) is available online.
- Poor link text: The fiscal year 2011 budget is available [online](#).

**Document Title**

- Seems obvious, but not always provided. Helps users know what a document is about before opening it.
Proper Identification of Language

- Some assistive technology users (including blind users) rely on text-to-speech (TTS) technologies to read content.
- TTS tools need to know what language to speak information in.
- If language is not defined, a speech synthesizer that is inappropriate for the language of the content may be used, impacting the understandability of the information.
Text in accessible documents can be resized to meet user needs.

A. Background
Since 1996, Local and successful in

B. Goals
The City of Meri and successful area's leaders

Since 1996
Proper Colour and Contrast

- Text within documents needs to have sufficient contrast to the background.
- Many people have some form of colour vision deficiency.
- Many people with low-vision need high-contrast for optimal clarity and ease of reading.
What Makes a PDF Document Accessible?

- PDF documents are able to address all of these needs.

- Some needs are addressed by the author
  - An accessible PDF document contains "tags" which convey accessibility information to assistive technologies.

- Some needs are addressed by the PDF reading tool (e.g. Adobe Reader)

- PDF documents can meet the requirements of WCAG 2.0
  - Techniques for addressing WCAG 2.0 are complete and will be included in the next update provided by the W3C (expected late March 2011).
Demonstrating Accessibility Features

- Access for blind users
- Access for users who have low-vision
- Access for users needing different color and contrast
- Access for users who are only able to use the keyboard
Creating Accessible PDF Documents

- Microsoft® Word is a very common tool for creating documents.
- Adobe® Acrobat® X includes many features to support the production of accessible PDF documents, including export to PDF via Microsoft Word.
- Microsoft Word also supports the creation of accessible PDF documents.
- Creating accessible PDF documents does not need to be difficult.
Creating Accessible PDF Documents

Steps

1. Prepare for export (one-time)
2. Provide headings
3. Provide accessible images
4. Use Word’s list and hyperlink features
5. Format columns properly
6. Identify table heading cells
7. Identify document language
8. Publish PDF document
9. Verify accessibility
Prepare for Export – Configure Adobe Acrobat X PDFMaker

- Preparing Adobe Acrobat X to output accessible PDF is simple.
- In the Microsoft Word “Acrobat” menu, select “Preferences” (previously named “Change Conversion Settings”)
- Ensure “Enable Accessibility and Reflow with tagged Adobe PDF” is checked.
- Once checked, this option will remain as set.
When using Microsoft Word’s “Save As PDF or XPS” feature, ensure that tagging is enabled.

Select “Options” in the Publish as PDF or XPS dialog.
Prepare for Export – Configure Microsoft Word

- Ensure that “Document structure tags for accessibility” is checked.
- This step is not necessary if using Adobe Acrobat X for PDF publishing from Word.
Using Microsoft Word’s styles feature provides necessary information for assistive technology users while also saving authors time.

Many authors do not use styles, typically because the benefits are not well-understood.

Using styles helps address accessibility and simplifies authoring.

Setting up styles

1. Authors should look a several documents they authored in order to determine if any patterns for applying formatting to headings are used.

2. Applying existing formatting to a style is simple. Just select the text with the desired formatting and right-click on the style button desired and select “Update […] to Match Selection”.
Prepare for Export – Setting Up Styles

With a reputation for excellence and a portfolio of software brands, Adobe is one of the world’s leading producers of software for digital imaging and multimedia. Adobe also claims a rich history of innovation. Our commitment to innovation is as strong today as it was when Geschke and Warnock founded Adobe. The two men initially sought to provide digital imaging and multimedia tools for professionals at the time: getting text and images accurately into print. A year later, they helped launch PostScript®, a technology that took the publishing world by storm, allowing printing text and images.
Prepare for Export – Setting Up Styles

- This process is recommended for Heading 1-6 styles.
- Existing heading styles in Word can also be modified to suit preferences.
- It is important to remember to use the styles rather than apply formatting to text directly.
Provide Headings

- Headings are provided by simply clicking on the heading text and then clicking on the appropriate style in the Styles toolbar.
- Convenient keyboard shortcuts are provided
  - Alt+Ctrl+1: Apply a Heading 1 style (change number for other heading levels)

Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years,
Provide Accessible Images

- Text equivalents for images are provided by right-clicking on each image and selecting “Size”.
- The dialog that opens has a tab labeled “Alt text” where there is a space to enter a concise description.
Microsoft Word will provide features for bulleted and numbered lists. These should be used since they provide the correct underlying structure.

Hyperlinks can be easily created by selecting the text to be hyperlinked, right-clicking and selecting “Hyperlink” (or using the Ctrl+K shortcut).
Use Word’s List and Hyperlink Features

- Microsoft Word’s “Insert Hyperlink” dialog allows the link target to be set.
- Simple web addresses are automatically turned into hyperlinks, and these correctly formed links will result in accessible PDF links.
Format Columns Properly

- Text boxes should never be used to create columns in Microsoft Word – the text will be out of order for a blind user.

Adobe Systems Incorporated

Adobe revolutionizes how the world engages with ideas and information. Our award-winning software and technologies have set the standard for communication and collaboration for more than 25 years, bringing vital and engaging experiences to people across media and to every screen in their lives, at work and at play.

The impact of Adobe software is evident almost everywhere you look. Whether people are collaborating at work, transacting online, or socializing with friends, businesses use Adobe software and technologies to turn digital interactions into richer, high-value experiences that reach across computing platforms and...

A rich history of innovation

Our commitment to innovation is as strong today as it was in 1982, when Chuck Geschke and John Warnock founded Adobe. The two men initially set out to solve a problem long familiar to creative professionals at the time: getting text and images on a computer screen to translate beautifully and accurately into print. A year later, they helped launch the desktop publishing revolution with Adobe PostScript, a technology that took the publishing world by storm with its radical new approach to printing text and images.
Format Columns Properly

- The column feature of Word creates a correct linear flow of text when exported to PDF (as well as in the Word document itself).
- To create columns, select the text that needs to be in columns, and select the number of columns needed from the "Page Layout menu "Columns" dropdown.
Identify Table Heading Cells

- Tables need to be created with the Microsoft Word table tool.
  - The Table tool is available in the "Insert" menu.
- Tables created using a series of tab stops to simulate the visual appearance of the table will not meet accessibility needs.
Identify Table Heading Cells

- Table heading rows can be identified in Microsoft Word using the Table Properties dialog.
- Ensure that the “Repeat as header row at the top of each page” checkbox is checked.
- This process will result in column headings. Row headings need to be added in Adobe Acrobat.
The document language needs to be set in Adobe Acrobat.

The “Document Properties” dialog is available from the File menu.

The “Advanced” tab contains a “Language” drop down where the language can be set.
Provide Document Title

- The document title should be set in Microsoft Word.
- The “Properties” option is available from the Office menu, in the “Prepare” submenu.
Provide Document Title

- The Title can be set in the inline or dialog view of the document properties.
Publish PDF Document

- Publishing the PDF document needs to be done through the "Acrobat" menu and the "Create PDF" button.
- Authors using the Microsoft Word "Save As PDF or XPS" feature can also produce tagged PDF.
Warning: Using “Print to Adobe PDF” will produce a PDF that has no accessibility information.
Verify Accessibility

- You've published a PDF document, and now need to verify the accessibility.
- For this task you will need a tool that provides a view of the accessibility information.
- Adobe Acrobat X provides the most comprehensive set of tools for examining and repairing the accessibility of PDF documents.
Adobe Acrobat includes an accessibility checking tool which provides useful information for authors interested in accessibility.

The Tools panel includes an option titled “Full Check” which runs a series of tests on the document.
Verify Accessibility

- The “Adobe PDF” set of tests will check several important items including
  - Equivalents for images
  - Document Language
  - Correct list and table structure
- No accessibility checking tool can verify that information is accurate, only that it is provided. For example, the Full Check will indicate when images are missing equivalents but a human is needed to verify that any text provided is appropriate for the image.
- When issues are identified, an accessibility report is provided which includes hints to address issues.
- Further verification is needed after the report is performed.
Verify Accessibility

Additional items that need to be verified include:

- Headings – structure and content
- Accessible images
- Columns (reading order)
- Table heading cells
- Document language
Verify Accessibility

- Headings can most easily be verified by ensuring that Microsoft Word headings are converted to PDF Bookmarks.
- Adobe Acrobat X preferences provide an option to “Convert Word Headings to Bookmarks”
Verify Accessibility

- Bookmarks are shown in the “Bookmarks” navigation pane, but the heading levels are not shown.

- To view heading levels, examination of the tags is needed.

- The tags navigation panel can be viewed by opening the View menu, selecting “Show/Hide”, selecting “Navigation Panes”, and choosing “Tags”.

![Bookmarks pane with Adobe Systems Incorporated and a rich history of innovation]

Verify Accessibility
Verify Accessibility

- Examination of the tags will allow authors to verify that headings are used appropriately.
- Headings may be written as `<H1>` or `<Heading 1>`. 
Verify Accessibility

- The Accessibility pane of the Tools panel in Adobe Acrobat X includes a button for the TouchUp Reading Order Tool.
- The TouchUp Reading Order Tool provides a visual view of the structural elements in the PDF.
Verify Accessibility

- The TouchUp Reading Order Tool provides a visual view of images and any alternative text. Verify that each image in the document has appropriate alternate text.

- Alternative text can also be examined by right-clicking on an image and choosing “Edit Alternate Text”.
The TouchUp Reading Order Tool also shows the overall reading order for each page of the document. Verify the reading order is correct for each page using this tool.
Verify Accessibility

- The TouchUp Reading Order Tool allows authors to verify or edit the structure of tables.
- Right-click on a table and choose “Table Editor” from the menu.
- Verify that table headings are correct for each table by using this tool.
Verify Accessibility

- The Table Editor displays TH (Table Header) and TD (Table Data) for each cell in the table. Verify that table headings are correct for each table by using this tool.

- If table headings are not correct, right-click on any cell and select “Table Cell Properties” to view the Table Cell Properties dialog.
The Table Cell Properties dialog allows authors to change a table data cell to a table header cell easily, by selecting the appropriate choice and whether the scope of the header is for a row or a column.
Verify Accessibility

- Verifying the language of a PDF document is simple – when the document is open (in Adobe Acrobat X), choose “Properties” from the file menu and select the “Advanced” tab.

- The language option should be set to the default language. Select the language if it is not accurate. This only needs to be done once per document.
Verify Accessibility

- Other tools are available for checking PDF accessibility that may be of interest.
  - Necentric Commonlook (http://www.net-centric.com/products/cl_s508_adobe.aspx)
What About Other Authoring Tools?

- Microsoft Word is not the only tool that is capable of authoring accessible PDF documents.

- Adobe InDesign®
  - InDesign provides support for tagged PDF.

- Microsoft PowerPoint®
  - Adobe Acrobat includes a PDFMaker plug-in for PowerPoint. Use of slide templates provided with PowerPoint and providing links, lists, and accessible text for images will address most accessibility concerns for basic presentations.

- Other tools also include:
  - OpenOffice.org™
  - Adobe FrameMaker®
  - Adobe Illustrator®
Resources

- Adobe’s Accessibility Website
  http://adobe.com/accessibility

- Adobe’s Acrobat Accessibility Guides
  http://adobe.com/accessibility/products/acrobat/training.html

- Adobe Accessibility Blog
  http://blogs.adobe.com/accessibility
Q&A